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Dear Student, 

 

We would like to take this opportunity to warmly welcome 
you to your course. At Oxford Learning College, we seek to 
ensure that all students have an enjoyable and productive 
relationship with the College, grow both academically and 
personally and leave satisfied. 

By enrolling and taking responsibility for your learning, you 
have started on a path that will interest and challenge in 
equal measures and allow you to develop, grow and leave 
with knowledge and skills that will be of great use to you in 
the working environment.  

 

We wish you the best of luck on your journey!   

 

Darren Wood and Deborah Coombe 
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1.Introduction 

 

 

 

 

 

 

 

As you prepare your plan for studying and further for submitting an 
assignment, you need to read the handbook again as there is valuable 
advice here to help you succeed.  

Your learning and completion of your course remains your responsibility, 
including the liaising with your tutor and the planning and submitting of 
work in a timely fashion. 

 
You can contact Student Services between 9AM and 5PM (GMT) from Monday 
to Friday by telephone. If you leave a message outside of these times, Student 
Services will get back to you as soon as possible on the next working day. The 
quickest way to get in touch with student services is to use the following 
methods: 

➢ Telephone 01865 595 263 
➢ ‘Ask A Question’ Link on Campus 

All telephone calls to and from Student Services are recorded for training 
purposes. 

 

  

Important Notice: This handbook is required reading for all 
students. 

This handbook has been written to help you settle into your course and 
get started. You should check the handbook regularly for updates; the 
cover page indicates the date of last revision.  Updates will be uploaded 
on the system for students to have access. 
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2.“On Campus” Account 
 

Once you have enrolled and received your log-in details, you will find yourself 
on the home page of your account, your “On Campus” terminal. A screenshot 
of this can be seen below: 

We have introduced a quick guide to the links that you may come across. 
Please note that this screen will differ depending on the type of course you are 
enrolled on. 

 

My Courses 

 
Where you go to view all your relevant course materials, assignments, and 
further Student Guides. 
 

Upload Assignments 

 
Where students go to upload their work. Please note that it is important that 
you upload your work in the corresponding unit slots. For example, your 
coursework / assignment for Unit 1 should go in the Unit 1 slot on your account, 
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the Unit 2 coursework / assignment on the Unit 2 slot, and so on. Any 
assignments uploaded in the wrong slots will be marked as “referred” (a Fail 
grade). 
 
 

Ask a Question 

 

Where you can go to either contact our Student Services team or your assigned 
tutor. Student services should only be contacted for technical issues, account 
enquiries, and general questions. Anything in relation to the course content 
should be referred to your tutor, the academic advisor. 
 

Schedule 

 
Where students can manage their course progress via an online calendar. 
 

Your Messages 
 

Make sure that you pay attention to the scrolling message panel found on the 
right-hand side of your screen. This panel will change as we continuously 
provide information on course updates and important news. This section will 
also provide you with a list to all the latest contests, prizes, and give-aways. 
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Your tutor 

 
You will be assigned with a tutor for the duration of your course who will be 
able to answer any questions you may have regarding the academic contents 
of materials. Please note that in most instances, your tutor will not contact you 
first, you will be required to contact the tutor should you ever need their 
assistance. We always recommend that when you start drop a quick note to 
your tutor to introduce yourself. 

 

Extra Material – “Merchandise” 

 
All Oxford Learning College study materials can be found online via your 
Campus account. You will not able to print your course materials. If you prefer 
a paper version of your materials, please note this is an additional cost found 
on the Merchandise section of our website. We also offer portable digital 
materials, although these are not printable, you are welcome to select this 
instead. 

 

Post – “Letters and Certificates” 

 
Oxford Learning College will not send anything via post unless the student has 
purchased this additionally via the Merchandise section on our website. We 
aim to be as paperless as possible to minimise our environmental impact. 

 
Course Duration 
 
Your course life begins as soon as your log-in details have been sent to the 
e-mail address provided in your enrolment. Once your course has expired, 
your account will be disabled. Please see the following table; 
 

Course Duration 

AS Level 1 Year 

A2 Level 1 Year 

Fast Track A-level 1 Year 

Full A-level 2 Years 
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3.Your most likely first questions about your A Level 

 
More information on your course can be found on our offline Campus home 
page (our website www.oxfordcollege.ac). The answers to commonly asked 
questions can also be found there. Below are the usual questions students 
tend to have. 
 

How are units assessed? 

Most units are assessed by an external written examination. Some courses 
contain practical exams. You will need to book your exams at a suitable exam 
centre. Currently, exams only take place in May/June of each year. You may 
find that local schools and colleges will allow you to sit the exam with them. 
Some courses contain coursework elements. This would need to be marked in 
the centre of your choice. Whenever you are liaising with an examination 
centre, make sure you quote the code of the course you are following. 
 
Our A-Level programmes in the “pre-2015 syllabus” consist of two parts; the 
AS and the A2. The AS is the first half of the award and is a stand-alone award 
whilst the A2 may only be completed once the student has completed their AS. 
You will be required to sit the AS component in one academic period, and the 
A2 component in the next academic period. Alternatively, you can also sit both 
AS and A2 components in one academic period, however, this is at the 
discretion of your chosen examination centre.  
 
Our A-Level programmes in the “post-2015 syllabus” consist of one part alone. 
You have the opportunity of choosing between two academic periods. Please 
note that you will be required to complete the entire course in one academic 
period only. You will also only be able to do this once; if you select the first 
academic period, the following academic period is no longer applicable.  
 
Please feel free to contact Student Services to attain your exam codes and the 
specific syllabus number required.  
 

A-Level Coursework and authentication 

A minimum of two units of work must be submitted for tutor marking prior to 
coursework submission for your tutor to authenticate your coursework. 
 
All coursework must be submitted online and as a hard copy sent by post to 
our premises in Oxford, along with a stamped, addressed envelope and the 
relevant authentication forms downloaded from your online student account. 
The hard copy will then be forwarded to your tutor for authentication, and will 
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then be posted on in the stamped addressed envelope. This should either 
return to you to be handed in to your exam centre for marking, or alternatively 
be addressed to your examination centre directly (though if this is the case, we 
recommend you include a cover letter addressed to the exam centre to ensure 
it is processed correctly upon being receipt by them).  
 
Please note that an online submission of your coursework must be submitted 
via your ‘My Assignments’ tab and not elsewhere. If you experience any 
issues with this, then please do not hesitate to contact us on 
contact@oxfordcollege.ac  
 

mailto:contact@oxfordcollege.ac
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4.Working with your Tutor 

You will have support throughout the duration of your course from your tutor, 
who has a great deal of experience and knowledge in the subject matter. All 
Oxford Learning College Tutors are trained in delivering distance learning 
courses and will be able to assist you. 

What your tutor can do for you 

Your tutor can provide advice on how to help you work through the course 
materials, answer your questions, and guide you through challenging concepts.   

What your tutor can’t do for you 

Your tutor cannot plan or complete your work for you, in part or in whole. They 
cannot proofread your work prior to submission and cannot simply “give you 
the answers”. 

How to make the most of your tutor interaction 

When contacting your tutor, you will get the best results and quickest 
responses if you can format your question in a clear, concise manner that 
allows your tutor to see exactly what you are struggling with. 

If you are stuck on something, before contacting your tutor try working through 
the course materials that cover the concept before sending the question. If you 
are still stuck, then ask your tutor for help, making sure to include the following 
in your message: 

➢ Unit Number 
➢ Page numbers (If applicable) 
➢ Your question 
➢ An explanation of your understanding of the topic (to allow your tutor to 

identify any errors and check your progress) 

The reason we ask for these details is to allow your tutor to answer to your 
question as directly and as quickly as possible, which minimizes the time 
before you can progress on your course. Consider the following two questions. 

Question 1. 

Hi, I don’t really understand my course, can you help? 

Thanks, Student A 

 

Question 2. 

Hi, I don’t understand how Ansoff’s concepts might not apply to a modern global 
business, as indicated on page 200, Unit 7 of the course materials. Can you help? 

Thanks, Student B 
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The first question lets the tutor know that you need help, but requires the tutor 
to ask a number of questions before they understand what you need help with, 
to which you will have to respond before they can answer your question. This 
delay means they cannot help you to progress at an optimal pace. 

The second question is much better, because it lets the tutor know exactly 
where you are, which concept you are working on and why you are having 
difficulties with it. This means their response can be directed at your question, 
so you will receive an answer much more quickly and you can move on in your 
studies. 

Appropriate contact with your tutor 

Oxford College takes interaction between students and Tutors very seriously 
and regularly reviews messages to ensure that standards are being maintained 
and to check that all contact is appropriate. All messages are logged and saved 
on Campus. 

Oxford College requires all parties to be polite, respectful and courteous at all 
times and will not tolerate rude, offensive or discriminatory language. 

Students are not permitted to share contact details or to contact tutors outside 
of the College messaging system. Tutors are instructed to ignore messages 
from students that are not from the Campus system. 

In the rare event that the Campus messaging system is unavailable, student 
services will facilitate communications between tutors and students. 
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5.Hints for effective writing 

When you write, you need to ensure that your writing follows these key points: 

➢ Uses clear, correct language. 
➢ Uses correct terminology. 
➢ Uses technical language where needed. 
➢ Does not use excessively wordily words for the sake of it. 
➢ Use British spelling where possible. 
➢ Harvard Referencing System (HR) to be used throughout your work. 

By writing in a specific and consistent style, your assignment will be much 
easier to read and evaluate. Using the correct terminology, as well as technical 
terminology is expected, but take care not to use excessively complex 
language for the sake of it. Aside from adding to your limited word count if 
applicable, it will not benefit your grade, but misusing complex language may 
make it harder to understand your point. 

 

 

 

 

 

 

1st Vs 3rd Person 

Generally, you will be expected to write in the 3rd Person. This means that you 
should avoid phrases like we, you and us. Instead you should be using phrases 
like he, she, it, they, him, her and them. 

Example: 

1st Person - “In this assignment, I will examine how theories of business 
management have developed over the last 2 years.” 

3rd Person - “Business management theories have changed over the last 2 
decades, with a variety of a different approaches emerging.” 

Formatting your work 

The specific format of your work is relatively open, as the only restrictions are: 

➢ It must be saved in an MS Word format. 
➢ It should be written in blue or black fonts. 
➢ It should be easy to read. 

You will want to ensure that your work is presentable and most importantly, 
easy for your tutor/assessor to read. We suggest that you use a standard font, 
such as Arial, Calibri or Times New Roman. Do not use fonts that would appear 

Tutors and Assessors are Human too! 

Remember that your tutor does not want you to fail. However, they do have 
to read through many pieces of work from students each week. By following 
the above guidelines, you can ensure that they find your work easier to read 
and understand. 
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unprofessional, or are hard to read. Your work should be written in size 11 or 12 fonts 

and double spaced unless otherwise stated. 

Make use of paragraphs to break your assignment up into easy to read chunks. 
This will make it easier for your Tutor/Assessor to read. In reports, headings 
and sub-headings should be used where necessary. 

When it is relevant, you may include visual images. On the Insert tab, the 
galleries include items that are designed to coordinate with the overall look of 
your document. You can use these galleries to insert tables, headers, footers, 
lists, cover pages, and other document building blocks. When you create 
pictures, charts, or diagrams, they also coordinate with your current document 
look. You can easily change the formatting of selected text in the document 
text by choosing a look for the selected text from the Quick Styles gallery on 
the Home tab. You can also format text directly by using the other controls on 
the Home tab. 

Most controls offer a choice of using the look from the current theme or using 
a format that you specify directly. To change the overall look of your document, 
choose new Theme elements on the Page Layout tab. To change the looks 
available in the Quick Style gallery, use the Change Current Quick Style Set 
command. Both the Themes gallery and the Quick Styles gallery provide reset 
commands so that you can always restore the look of your document to the 
original contained in your current template. On the Insert tab, the galleries 
include items that are designed to coordinate with the overall look of your 
document.  

Referencing  

As mentioned in the getting started section of the Handbook, you are expected 
to use the Harvard Referencing System (HR) throughout your work, including 
intertextual references and providing a reference list at the end of your 
assignment. 

There are several reasons why you need to use the HR system, including 
showing your sources, demonstrating that you have read widely on the topic 
and providing proof for claims. Most importantly it helps your tutor to identify 
which parts of the work are your original writing, which come from other sources 
and which portions have been inspired by other authors. By omitting relevant 
references to a text, you are passing off the work of others as your own i.e. 
plagiarism. 

How to reference 

Learning how to reference is straightforward, as you simply must follow a 
specific process for each reference. Referencing can be time consuming if you 
don’t keep a list of your sources, you may wish to use the appropriate section 
in your Portfolio to list all references that you use when researching and writing 
your assignment.  
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To reference a source, you need to follow two steps: 

1. Intertextual Reference - Place a reference to the source in the body of 
the text or assignment. 

2. Reference List – Add your reference to your reference list at the end of 
your assignment. 

Intertextual references 

When should I use an Intertextual Reference? 
You should use an intertextual reference in one of the following circumstances: 

➢ You have made a factual statement. 
➢ You have referred to someone else’s work, theory, concept or idea. 
➢ You have used an indirect or direct quotation. 
➢ You have discussed, paraphrased, inferred, or otherwise alluded to 

someone else’s work. 

How do I make an Intertextual Reference? 

An intertextual reference requires, at a minimum, the author’s surname name, 
date of publication and page number, if known. Depending on how you have 
presented the information requiring the reference there are several options on 
the use of the reference. Two examples are seen below. 

“In addition, by comparison of gender, life expectancy is higher for women than for men almost everywhere 

in whole world (Kalban 2002, PP.45).” 
“According to Kalban (2002, PP.45), “Today, males have greater mortality than females throughout the 
world.” 
 

You can see that when you have used the authors name directly in the text, 
you simply need to use the publication date and page. If, however, the name 
does not arise naturally in the text, you will need to include it in the reference.  

How do I include reference if there are multiple authors? 

If you are referencing multiple authors from separate sources, they must be 
referenced individually, in the manner explained above. If you are referencing 
multiple authors from the same source, then you need to do one of two things. 

If there are 2 or 3 authors, you need to reference all their surnames, as above. 
If there are 4 or more authors, then you need to use the phrase “et al.” which 
means and others in Latin. For example: 

“However, research by Wallace et al. suggests that this trend may be reversing (2009, PP.42)” 

“Recent research suggests that this trend may be reversing. (Wallace et al. 2009 PP.45)” 

“However, Wallace et al. state that “there is reason to believe that this trend will not continue and is 
in the process of a reversal” (2009 PP.45) 
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What if I can’t identify the author, or it is a corporate author? 

By corporate author, we mean that there is no individual author, which is 
common for works published by a large organisation or governmental bodies, 
such as the NHS and BBC. In this case, you may use the abbreviation for the 
organisation in the reference, provided that you have previously used the full 
title of the organization earlier. You then enter the date as you would for an 
individual author. 

What if the source is a website, without a clear author?  

In this case, you need to establish the ownership of the website. For example, 
if you were to quote from the OxfordCollege.ac website, you could see that the 
copyright is claimed by Oxford Learning College in 2014. Note that websites 
have special requirements when adding them to the reference list. 

 

Figure 1 - One method for locating the owner of a website. 

What if the source is cited by another author? 

You may encounter references that are cited in another author’s work that you 
wish to include. While it is preferable that you read the original authors work, 
you may reference it in the following way. 

“Williams suggests that although the trend may be subject to fluctuations, it has remained consistent over the 

last 10 years (2007 cited in Jones, 2009, p.99) 

Reference list 

At the end of your assignment, you need to build a reference list. It will save 
you time and energy to build this list as you add references, rather than trying 
to build it as you work. You can use the reference table in your portfolio to help 
you to build the list. 

Your reference list should be in alphabetical order. If you have used multiple 
sources from the same author, or authors that share the same name, place 
them in chronological order.  You can see a sample of a reference list entry 
below, which has been broken down into its components. 

Bloggs, J. 2012. How to build a reference list. Oxford: Generic Press 

First, you include the author’s name, followed by initial(s). Next you include the 
date of publication, followed by the title in Italics. Then you insert the city or 
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town where it was published and the publisher. Pay particular attention to the 
punctuation – it is very important. If the book is not the first edition, you need 
to include the edition after the title. The example above would read “Bloggs, J. 
2012 How to build a reference list 4th Ed. Oxford: Generic press” 

Websites need to have additional information added. You must follow the same 
conventions as a normal reference, but you need to add a link to the page in 
question and include the date on which it was accessed.  

You should also keep a screenshot of the page if possible, in case it is removed 
or updated. 

Reference images 

Reference images 

When referencing images, you need to include the photographer/artist, year in 
which it was created, its medium and its location. Please see the template 
below for an example. 

Single Author 

Bloggs, J. 2012. How to build a reference list. Oxford: Generic Press 

Multiple Authors 

Bloggs, J. and Doe, J.J. 2013. How to build a reference list, The ultimate guide 2nd Ed. Cambridge: One Up 

Press 

Website 

Oxford College, 2014. Top tips for using the internet for research. [Online] Available at: < 

http://www.oxfordcollege.ac/news/top-tips-using-internet-research> [Accessed 11 July 2014] 

Image (Online) 

Brooke, B. 2013. Orange Eyes [Electronic print] Available at: 

<https://www.flickr.com/photos/89367001@N08/9385598696/> [Accessed 11 July 2014] 

Image 

Evans, R. 2014. A street image [Photograph] (London, Tate Gallery) 
 

Proofreading 

You should always proofread your assignment before you upload it to your 
tutor, as once uploaded the work cannot be retrieved. Proofreading ensures 
that you don’t make silly mistakes that will negatively impact your work. It also 
ensures that you have a chance to review your work and ensure that it is well 
written. 

If possible, leave the assignment alone for 24-48 hours before proofreading, 
as you will find that more errors can be spotted this way. Ideally, have your 
friends or family read it for you. Be wary about giving a copy to other students.  

http://www.oxfordcollege.ac/news/top-tips-using-internet-research
https://www.flickr.com/photos/89367001@N08/9385598696/
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yourself in trouble. 

 

 

 

 

 

 

 

 

Plagiarism 

Plagiarism is the act of passing off the work of another author as your own and 
if you are guilty of it, you will be liable to severe penalties, including but not 
limited to,  

Avoiding plagiarism 

Plagiarism can be intentional or unintentional, but by its very nature it is 
extremely hard to differentiate between a mistake made in good faith and overt 
plagiarism. Students are therefore advised to take a great deal of care with 
references. 

In addition, before submitting work, you are required to make a declaration that 
the work is your own, making a false declaration is classed as ´malpractice´ 
which can also result in dismissal from the course. 

Students can make use of a range of Anti-Plagiarism software to check their 
work before submission, but the single best way to avoid a penalty is to be 
honest, write your own work and ensure that you carefully reference all sources 
of information that you have used. As a general rule, you should expect less 
than 10% of your work to consist of quotes or any other use of other people’s 
words.  In some disciplines, such as Law, there is often a necessity to use 
greater amounts of direct quotations, this is expected and only becomes a 
problem if referencing is inaccurate.  

  

A note on Assignment/Essay writing services 

You may be tempted to use one of many online Assignment/Essay writing 
services to complete your assignment/essay for you. These sites will at best, 
generate an assignment that is unlikely to be suited to your study and at 
worst will send you a plagiarised assignment. 

All assignments are electronically scanned before being reviewed by your 
assessor. Plagiarised content will be found and you will not receive credit for 
it.  

Do not use assignment/essay writing services! 
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6.Uploading your assignment 

When you have completed your assignment, you will need to upload it to your 
tutor/assessor. To do this, you need to log into Campus. Once logged in, you 
should click on the upload assignments link and click on your course. From 
there you will be asked to click a button, indicating that you are uploading your 
own work and that you are aware of the penalties of uploading plagiarised 
content. You will then need to click the browse button to locate your 
assignment.  

When you are uploading, you should receive a message and asked to confirm 
you have read this message before you are able to upload.  Make sure you 
read and understand the message before confirming. 

 

If you find that you do not receive this message please report this immediately 
to Student Services. 

If you accidentally upload an assignment in the wrong unit slot 

Please contact student services as soon as possible, using the Ask a question 
link. 
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7.Appeals on feedback from your tutor 

Programmes are delivered by an online system and therefore processes are in 
place to ensure that assessment is rigorous but flexible and fair to 
accommodate the needs of all involved. In addition, it is important within 
distance learning delivery to maintain a student-centred approach and consider 
the difficulties with meeting the learning preferences of students within a virtual 
learning platform which makes facilitation of learning more complex that via a 
traditional model. 

With this ethos in mind the assessment process allows for considerable 
flexibility yet offers security of process in a timely and professional assessment 
and feedback process. Assessment is carried out by qualified tutors and 
verified to ensure accuracy and consistency and that we are maintaining the 
integrity of the level of course you are studying. 

The system is highly effective and reliable, being endorsed by awarding bodies 
such as Edexcel/ATHE/CIE and the ABC National Award Organisation. 

Although Oxford Online College are confident in the assessment process, it is 
acknowledged that differences of opinion may arise and errors are possible 
even in the most rigorous system. On return of an assignment, if you have any 
queries with regards to the feedback or grades you receive, you should contact 
your tutor who will be happy to offer further explanation or guidance. If your 
concern continues, further verification will take place.  The result of this further 
verification will be final. 
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8.Student Complaints Procedure 

The College values greatly the views of its students. It aims, therefore, to 

manage complaints in a way that is sensitive to the needs of each specific 

case, and supportive of the College’s overall ethos.  

 

There are a number of informal channels through which is it hoped that most 

problems can be resolved.  These have been explained earlier. If, however, 

you need to pursue a complaint formally after attempting to resolve your issue 

via the informal channels, you can be sure that the College will treat it seriously 

and impartially, on the basis set out in this document. 

 

Advice on how to use the complaints procedure is available from a variety of 

sources, but in the first instance students are encouraged to contact the 

Student Services Team, by sending an email to contact@oxfordcollege.ac 

 

What complaints can be considered? 

1. Grounds for complaint (after informal attempts) might include: 

• Dissatisfaction with standards of academic provision (for example, 

the content and structure; resources and facilities; arrangements 

for assessment and information provided to you about your 

course). 

• Dissatisfaction with the quality of supervision and tuition. 

• Failure to meet obligations promised to you by the College. 

• Persistent deficiencies in standards of services you have been 

promised. 

• Harassment, bullying and victimisation by College 

representatives. 

 

2. Generally, complaints are most easily resolved if they are raised at the 

time the problem first occurs and with the person/s directly involved. 

Often, students will be able to resolve their issue, simply by discussing 

it with a Student Advisor or with their personal tutor. 

3. If students cannot, or feel unable to, resolve concerns in this way, they 

can put their complaint in by completing a complaint form available 

from the student services team. The Academic Director, or a nominee, 

will seek to provide them with a response to their complaint within 21 

working days. 

mailto:contact@oxfordcollege.ac
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4. Once your complaints form has been received, your case will be 

investigated and a full report presented to the Academic Director for 

consideration.  

5. Non-completion of this form will mean a complaint is not investigated. 

6. Refunds on the purchase of your course are available only if claimed 

within the first 14 days of enrolling. 
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9.Special considerations and reasonable adjustments  

Oxford Learning College recognise disabilities are of a diverse nature and we 
do not tolerate discrimination on the basis of disability.  We allow fair access to 
our courses for all students. 

Equal opportunities and diversity categories include age, disability, gender 
reassignment, sexual orientation, marriage and civil partnerships, national 
origin, ethnicity, religion or belief, pregnancy and maternity.  

All candidates have an equal opportunity to demonstrate their knowledge, skills 
or understanding to the level of attainment required to enrol and succeed. 
Barriers to entry and continuous learning via on-line are removed where 
possible.  

However, in terms of sensory disability the responsibility lies with the student 
to make appropriate arrangements necessary to progress with their learning. 
Unfortunately, the college does not provide equipment necessary for students 
with visual difficulties. 

Students who suffer with health during their course are provided with support 
upon medical reports from doctors, psychiatrists and other specialists.  The 
College, wherever the Awarding Bodies will allow, will provide extension to 
programmes as requested.  Individual student tutors are made aware, without 
disclosing confidentiality, of the problems their student may be experiencing. 

 
 


